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Overview
The tool can be used to generate characteristic plots for a permanent magnet synchronous machine (PMSM) with known motor
parameters that are commonly provided in the datasheets of motor suppliers. 

Tool Features

Basic functionalities

The basic feature set can be used in the trial version (free of charge) for an unlimited time. The only restriction is that generated plots can
only be used publicly with a professional license.

List of the most common basic functionalities:

read data sets from a database delivered along with the application
customize or define new data sets for analysis (including saving the parameters to a file for later use)



plot maximum torque versus speed assuming different operational modes
plot d and q-axis currents needed to realize different operational modes
specify target operational points (defined as required torque at a certain rotor speed)
analyze required currents, operational modes and energy efficiency at target operational points
save and load target operational points to or from a file
interactive plots with additional information when hovering over it, zoom function and more

Professional functionalities

The professional features can be unlocked by requesting and activating a professional license via the "License Manager". More
information to the license request can be found in the License Management section.

List of the most common professional functionalities:

generate an analysis report with the characteristic plots and additional explanations
analyze the effect of a range of temperatures or supply voltages towards the range of operation
analyze the effect of motor parameter tolerances towards the range of operation
estimate power consumption and efficiency over the range of operation and at specific operational points
feel free to use the generated documents publicly

Torque-Speed-Plot
The torque-speed-plot will visualize the maximum achievable torque of the machine under analysis at certain rotor speeds. An example
plot is shown below.

The different plot lines represent different operational modes that are used. The abbreviations are defined as

MTPC: Maximum Torque per Current
FW: Field Weakening
Resistive FW: Field Weakening with consideration of the phase resistance

In addition to the distinct lines there is a contour plot showing the maximum energy efficiency for every operational point within the
allowed or reachable operational region. It is discretized to steps of 10% meaning that regions without a line are in the range between the
surrounding efficiency contours.

Operational-Modes-Plot



The operational-modes-plot will visualize the values of d and q-axis currents for the machine under analysis that must be realized to work
in a certain operational mode. An example plot is shown below.

The different plot lines represent different operational modes that are used. The abbreviations are defined as

MTPC: Maximum Torque per Current
MTPV: Maximum Torque per Voltage
Resistive MTPV: Maximum Torque per Voltage with consideration of the phase resistance
FW: Field Weakening
Resistive FW: Field Weakening with consideration of the phase resistance

The two contour plots, Iso-Torque and Iso-Speed, show lines of d and q-axis currents that result in the same torque or rotor speed,
respectively. The generated torque is written to the lines in Nm, the speed is annotated in rpm.

Target-Operational-Points
In the app there is another tab for specifying target operational points (TOPs). Those points are individually defined as a required torque
value at a certain rotor speed. The table view is shown below.



By pressing "Make Plot" the selected characteristic will appear on screen including the target points as dots like in the example plots
above. The actual plot that is opened will be dynamic with annotations when hovering over the plot region showing for example efficiency
and other information about each TOP.

When pressing "Generate Report" a report document will be exported. A table will be included into the report summarizing the results for
each TOP defined in the table. If a target point is not realizable within the allowed operating regions it will appear as "no solution". An
example for the report table is provided below

Tolerance Plot
The tolerance plot will show a torque-speed-plot considering the best and worst-case combination of parameters that show some
tolerance. The tolerance value can be specified in a window that will open on plot generation. The resulting plot will look like the one
below. If this plot has been generated it will also be included into the report. Just start the report generation afterwards.



Variable Supply Voltage Plot
This plot will show a torque-speed-plot considering different supply voltage levels. The level values can be specified in a window that will
open on plot generation. The resulting plot will look like the one below. If this plot has been generated it will also be included into the
report. Just start the report generation afterwards.

Device Temperature Plot
This plot will show a torque-speed-plot considering different operating temperatures. The temperature values can be specified in a
window that will open on plot generation. The resulting plot will look like the one below. If this plot has been generated it will also be
included into the report. Just start the report generation afterwards.



Supply Current Plot
The supply current plot will show the expected supply current over the maximum operating range. For many applications the amount of
current a motor is allowed to consume is limited. With this plot an early evaluation is possible. The inverter efficiency can be provided in a
window that will open on plot generation.

Actions
Make Plot

Pressing "Make Plot" will run a motor analysis and open the selected characteristic plot in the default web browser. The plot will be
dynamic allowing for zooming, panning and scaling. It will show annotations when hovering over the plot region. By clicking on a legend
entry plot traces can be unselected and (re-)selected to hide or show them, respectively. If such a plot is desired to be stored to disk it is
highly recommended to not use the browser's save option but to click on "Generate Report". It will save all characteristic plots as dynamic
and static file as one file each. An alternative approach would be to copy the plot file from the temporary directory where it has been
generated.



If there are points specified in the Target Operational Points table those will be gathered and plotted along with the generic characteristic
lines.

Generate Report

The "Generate Report" button triggers the export process of a report file. It will open a file dialog to select where to export files to. It will
only accept folders. Specifying file names is not possible. The export process will save the characteristic plots as both dynamic (html) and
static (png) objects and it will generate a report also as html file. The report includes the most relevant information from the analysis like
the Target Operation Points table described above and the plots that have been generated before.

If plots from the advanced plots menu are desired to appear in the report file, they have to be generated before starting the report
generation.

Save Database File and Load Database File

Within the "File" menu in the menu bar there are options to save and load a database file. If a device parameter set has been appropriately
defined inside the parameters table, the data set can be stored with the "Save" option. If the program will be executed another time, this
data set can be restored by the "Load" option. As long as the file is formatted compatibly, there is no restriction to adding items via a text
editor to have one file including several specific machines.

Save Operational Points and Load Operational Points

Within the tab "Target Operational Points" there are buttons to save and load TOPs. If a list of TOPs is specified in the table the "Save"
option can be used to export them to a file. This file can be loaded again after re-execution of the program or after changes have been
made that should be reverted.

Note, that TOPs do not have to be saved to be included in the plots that are generated.

Advanced plots

In the advanced plots section of the menu bar you can generate plots that show advanced characteristics. Possible options are presented
above.

Help

The "Help" menu in the menu bar contains options to open this help page or to get in touch with the Support (see Contact Support
section).

Motor Parameter Help
This tool is designed to take only datasheet parameters to provide insights of a motor's range of operation. However, not every datasheet
includes the same parameters. In this section, some guidance is provided about how to come to the parameters in the tool by converting
typical other datasheet values.

Permanent Magnet Flux Linkage
In most motor datasheets instead of the permanent magnet flux linkage, there are other parameters provided like a torque constant or a
voltage constant. Those values can be converted to the PM flux linkage as follows.

From a torque constant

The torque constant can be converted to the permanent magnet flux linkage using the torque equation

For some motor construction types, especially in case of surface-mounted PMSM, the d and q-axis inductances are basically identical. In
this case the equation simplifies to



leading to

From a voltage constant

The voltage constant can be converted to the permanent magnet flux linkage using the d-axis current dynamics. When the terminals
are only connected to a voltage measurement device no currents are flowing, consequentially simplifying the equation to

leading to

If the voltage constant is given with a rms-measured value a scaling factor of sqrt(2) needs to be added. Also, often the speed is measured
in krpm which again needs to be converted to base SI units. This leads to

if the voltage constant is provided in V/krpm.

Stator Phase Resistance
Some datasheets provide the actual phase resistance, but most of them specify a value measured from one to another terminal, mostly
called line-to-line resistance. This value needs to be halved to get to the phase resistance, i.e.

D and Q-Axis Inductances
Some datasheets might provide the actual d and q axis inductances, but most of them specify an inductance value measured from one to
another terminal, mostly called line-to-line inductance. This value needs to be halved to get to the phase inductance. If specified as one
single value there is no way of differentiating between d and q axis value, so it is just

If there is a characteristic of line-to-line inductance for a given angle one can determine the d and q axis inductances as the values at
certain angles, more specifically

License Request to Activate the Tool
In order to request a license, open the "License Manager" and click on "Request License Code". A prefilled e-Mail will open, ready to be
sent.

mailto:support@moteon.com


Alternatively, you can manually write to support@moteon.com to ask for a license code.

After receiving the license code, paste it in the text field and click "Activate". Your app should now switch to the professional version. If
not, please contact the support again.

Customer Support
In order to get technical support open the "Help" menu and select "Contact Support". A prefilled e-Mail will open that already includes
some information of your system configuration and the log. Please describe your problem in sufficient detail that it can be reproduced.

Alternatively, you can manually send a message to support@moteon.com describing your issue.

Legal Statements
Data Protection
No personal data is stored in the MOTEON Motor Analysis Tool.

Export Control Classification
The Software contained in this package may be subject to export control:

ALNR: N

ECCN: N

US: ECCN-US: EAR99

SICLASS: N

MYCLASS: N

MXCLASS: N

HKCLASS: N

Software classified with “ALNR not equal to N“ are subject to European or German export authorization when being exported out of the
EU.

Software classified with “ECCN not equal to N“ are subject to US re-export authorization.

Software classified with “SICLASS not equal to N" are subject to Singaporean Strategic Goods Control authorization when being exported
out of Singapore.

Even without a label, or with label "ALNR:N" or "ECCN:N" authorization may be required due to the final whereabouts and purpose for
which the goods are to be used.

Furthermore, the specified export control classifications are not binding, as export control regulations are subject to interpretations,
changes and possible differences in national requirements. The ultimate determination of applicable export control classifications and
related categorizations remains solely your responsibility.

mailto:support@moteon.com
mailto:support@moteon.com


Infineon makes no representation as to the accuracy or reliability of the information provided. You agree to use this information at your
own risk and to hold Infineon harmless in the event of any damages or penalties incurred by any party based on your use or reliance on
the information provided here.

Included Third Party Licenses
The package to which this Agreement forms part of contains Open Source Software located in the following directories/files: Default
directory is:
C:\Infineon\Tools\%ToolName%\%Version%\
Installation folder of the Software may vary according to Licensee’s selection during installation process.
For copyright information, licensing terms and additional information (e.g. on how to obtain the source code of such Open Source
Software), please refer to “licenses” folder.
Default directory is: C:\Infineon\Tools\%ToolName%\%Version%\licenses
Complete directory may vary according to Licensee’s selection during installation process.

Python:

Copyright © 2001-2022 Python Software Foundation; All Rights Reserved.

The Python version included in the tool files is 3.8.5.

No changes have been made in the Python Source Code.

Qt package:

GNU LESSER GENERAL PUBLIC LICENSE

The Qt Toolkit is Copyright (C) 2015 The Qt Company Ltd.
Contact: http://www.qt.io/licensing/

You may use, distribute and copy the Qt Toolkit under the terms of GNU Lesser General Public License version 3, which is displayed below.
This license makes reference to the version 3 of the GNU General Public License, which you can find in the LICENSE.GPLv3 file.

-----------------------------

This application's graphical user interface (GUI) is implemented using the Open Source Library Qt6 distributed by the PySide6 Python
package. This package is provided under the LGPLv3 license which requires to include the library's source code or link to it.

The currently used PySide version is 6.2.0

The source code of Qt6 can be downloaded at
https://www.qt.io/product/qt6

Alternatively, you can download the PySide6 Qt distribution at
https://pypi.org/project/PySide6/

To exchange the Qt library used by this tool all Qt dll files in the executable folder need to be replaced by the files of the target version.
Note, that certain function calls may not work when using a different version of Qt.

No changes have been made in the Qt library by the author of the Motor Analysis tool.

Pillow package:

The Python Imaging Library (PIL) is

Copyright © 1997-2011 by Secret Labs AB
Copyright © 1995-2011 by Fredrik Lundh

Pillow is the friendly PIL fork. It is

Copyright © 2010-2022 by Alex Clark and contributors

Like PIL, Pillow is licensed under the open source HPND License:

By obtaining, using, and/or copying this software and/or its associated documentation, you agree that you have read, understood, and will
comply with the following terms and conditions:

Permission to use, copy, modify, and distribute this software and its associated documentation for any purpose and without fee is hereby
granted, provided that the above copyright notice appears in all copies, and that both that copyright notice and this permission notice

http://www.qt.io/licensing/
https://www.qt.io/product/qt6
https://pypi.org/project/PySide6/


appear in supporting documentation, and that the name of Secret Labs AB or the author not be used in advertising or publicity pertaining
to distribution of the software without specific, written prior permission.

SECRET LABS AB AND THE AUTHOR DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS.
IN NO EVENT SHALL SECRET LABS AB OR THE AUTHOR BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY
DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

 


